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#1 - How to identify wildflowers

Regardless of what you’re photographing, it's always important to know your subject.
Knowing about wildflowers will help you find the ones you’re looking for, and help you put
names on flowers that you stumble upon.

Here are a few tips on how to get started with identifying flowers:

Get to know your local area

The best (and most rewarding) way to identify wildflowers is to get to know your local area.
This sounds tough, but it really isn’t—-buy a good guidebook or just browse Flickr for wildflower
photographs from your area.

After you look at a bunch of wildflower photos from your area, you’ll take mental note of the
ones you’re naturally drawn to, and you’ll recognize these flowers once you’re out on the trail.

Ask a park ranger
If you took your photo at a state or national park, show the photo to a park ranger (or describe

the flower to them), and they will most likely identify the flower for you—it’s their job and usually
their passion to know that park and all of it's native inhabitants.

Post your photo to an online forum

Why not call upon the many users of the Internet to help identify the flower for you? Post
your photo on a site like Flickr, and add it to one of the flower groups. Posting to one of these
groups or forums is also an excellent way to get some feedback on your photo!

Search for the flower in an online database

It's difficult to create a complete online database of all the world’s wildflowers (there are just so
many!), but here are a couple of good ones out there:

+ My Wildflowers - http://www.mywildflowers.com/
» Wildflower Information .org - http://wildflowerinformation.org/default.asp
* FloraSearch - http://citnews.unl.edu/florasearch/what.shtml

For more, visit www.photonaturalist.net Article by Steve Berardi
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#2 - The secret to getting perfect light

Wildflowers display some of the most brilliant
colors found in nature. And, for good reason—
they’re fiercely competing with each other to
attract their pollinating friends: the insects and
a few species of birds.

However, their brilliant colors often make them
difficult to photograph. Have you ever come
home with a full memory card only to find out
that all those beautiful flower photos you took
have blown out highlights, washed out colors,
and harsh shadows?
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Well, there’s a secret to avoiding all these
problems, and I'm going to tell you what it is.
Are you ready?

The only way to get absolutely perfect light for
your wildflower photographs is to photograph
them on an overcast day. The thicker the
clouds, the better. And, if it just rained—perfect.

Columbia Lily (Lilium columbianum)

The clouds act as a natural diffuser of the Sun’s light, so when there’s an overcast sky, you'll
get the most balanced natural light possible.

On the other hand, when the Sun is shining brightly on a clear day, the light will be severely
harsh, and result in blown out highlights. Since the colors of wildflowers are practically all
highlights, this is a huge problem!

Not only will you get blown out highlights, but you will also get harsh shadows, which are
almost just as bad! Here’s a photo that illustrates both of these problems:

The red arrow points to the blown out
highlights, and the blue is pointing to the
harsh shadows—both created from direct
sunlight.

So, ideally, you’ll want to shoot your wildflower
photos on an overcast day. But, don’t worry,

if you can’t wait for the perfect light, you still
have a few options (see the next tip).

Article and photos by Steve Berardi




#3 - What to do if you can’t wait for perfect light

What if you can’t wait for an overcast sky? Or,
maybe they just occur so rarely in your area?
Well, the next best thing you can hope for is a
partly cloudy day. Then, wait until the sun goes
behind a cloud before you shoot your photos.
This won’t provide as good a diffusion as a
completely overcast sky, but it will still get you
great results.

Ipsesag 8ARIS Ad 6002 (2) 1ybLAdoD

For example, the wildflowers of the Mojave
Desert bloom for only a few weeks, and this
desert rarely has an overcast day. So, in order to
take the photo at the right, of a Desert Dandelion,
| just waited until a few clouds blocked the Sun.

Desert Dandelion (Malacothrix glabrata)

You also have another option to compensate for poor natural lighting, and that is to build

an artifical light diffuser. Don’t worry, you can build one in two easy steps. All you need is
scissors, tape, a wire clothes hanger, and a shower curtain (make sure you get a semi-clear
and non-tinted one).

And, here’s how to build it;

1. Bend the wire hanger into a square or circular shape. You can do this just by pulling on the
bottom of the hanger and bending it until you get a nice square shape.

2. Place the shower curtain over your bent hanger, and cutout a piece that is a little bigger
than the wire frame. Then, just tape this onto the frame, and you’re done!

You should have something that looks like the photo below (please forgive my poor product
photography skills).

How to use your new diffuser

Using your new diffuser is easy—just hold it
between the sunlight and the wildflower you’re
photographing. Make sure you’re holding it in
such a way to diffuse ALL light that's coming
into the frame (not just the light that’s shining
on the flower).

For more, visit www.photonaturalist.net Article and photos by Steve Berardi


http://photonaturalist.net

#4 - How to get a proper exposure

Wildflower photography has endless possibilities when it comes to proper exposure.
Basically, anything goes. However, it is very important that you know what you want to
achieve in the final image. We will examine how to properly expose a wildflower called the
Fringed Gentian (Gentianopsis crinita). The first two images below are identical except for the
lighting. The photo on the left was taken in full sunlight and the photo on the right taken with
artificially diffused light.
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Phot A Photo B

The next two photos were taken on a day with thin cloud cover providing a similar effect to the
artificial diffused light. In this lighting condition, you have many opportunities to be creative
since the sun will be filtered through various lighting conditions. Here both soft lighting and
backlighting are evident.

!pmJéG 9IA A 6002 (9) buAdoD
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#4 - How to get a proper exposure (continued)

There are three elements that will affect what exposure you should use:

1. Wind
2. Lighting
3. Angle of view

Let’'s examine each of these in detail using the above four photos. Before we begin though,
use of a tripod is virtually mandatory and all of these photos were taken with a tripod and a
100mm lens.

Wind

Of all the elements that affect your wildflower photography, wind is the most crucial. If your
sole purpose of taking wildflower photos is to record the best possible image of a wildflower
for documentation, then capturing as much detail of the flower, leaves and overall structure
of the plant are vital. It will require good depth of field and a super sharp image with lots of
detail. To achieve this, you will need a higher f-stop aperture setting.

This is where wind plays a significant role in your choice of available exposures. Ideally, you'l
want an aperture of at least f/8. In order to freeze any motion in the wildflower due to even
the slightest wind, a shutter speed of at least 1/200 second is required and needs to be even
faster if the wind is much over 10 mph.

Photo A is the type of shot we are describing. Because the flower is slightly darker than
neutral gray, opening the aperture by one full f-stop was necessary. The photo was taken at
f/8 at 1/250 second with an ISO 200. Using a lower ISO would decrease noise a bit more, but
would’ve required a larger aperture or a slower shutter speed.

Photo B is the exact same as Photo A except a softer lighting technique was applied. An
artificial diffuser was used to soften the harsh sunlight. Doing this creates a slightly lower light
situation and forces you to either increase ISO or sacrifice sharpness and/or depth of field.
The best choice may be to sacrifice a bit of each. Keeping the ISO at 200, this photo was shot
using an aperture of f/6.3 (one half less than Photo A) and at a shutter speed of 1/160 second.
Close examination of the photo will reveal slightly less depth of field than Photo A and a bit of
sharpness loss due to movement created by wind.

Lighting

Photos A and B show how lighting can affect the final image, bright sunlight versus
diffused sunlight. Both have a place of importance in the capturing of wildflower

images. But which one is generally more pleasing to the eye? If an artistic element is
what you are seeking, then diffused sunlight is the solution. Lighting in Photos C and D
are naturally diffused sunlight, meaning thin cloud cover created a similar effect as Photo B
but much more pleasing.



#4 - How to get a proper exposure (continued)

Also, with naturally diffused sunlight as the sun reveals itself through the cloud layer various
lighting conditions are produced. The result is a photo that may never be duplicated again
unless exactly the same natural elements are present (lighting, time of day, time of year, etc.)
This is what makes photos like these stand out more in an artistic view than those like Photos
A and B.

Another element to lighting is time of day. Photos C and D were taken at midday with the sun
virtually directly overhead. You can see the resulting effect of the brightness inside the flower
itself.

Exposure decisions for naturally diffused light have to take into account a couple of elements:
depth of field and wind motion. In Photos C and D, the decision was made to create an image
with less depth of field by blurring the background. Because wind wasn'’t a factor, the resulting
exposure was /5.6 at 1/100 second.

Angle of view

The final element for exposure decisions and closely related to the first two is what angle to
capture the image. The majority of wildflower images you see are taken from an angle most
people view them, standing up and looking down. Or possibly even in a kneeling position but
still looking down. Many of our most beautiful wildflowers barely reach a foot or two in height.
The Fringed Gentian here is typically less than two feet tall, occasionally reaching three feet.

Capturing an image from an angle that people never withess makes that image unique and
inspiring. Photos A and B were taken from the normal viewing angle, that being slightly
downward or somewhat level if a person were kneeling. Photos C and D were taken from
slightly below looking upward at the flower, an angle that can only be seen if a person were
lying down (not the norm for wildflower viewing!). From this angle you create an image that
makes a viewer of the photo think about it longer and take into account how the lighting is
shown and the texture of the flower.

Summary

Getting your viewer to look at your photo longer is what makes a great photo. The effects

of wind, lighting and angle of view all play an important role in that. But proper exposure is
what they grade the photo on. It is highly recommended that you shoot in the RAW mode and
possibly bracket your exposures to capture the perfect one.

The result of your decisions on proper exposure will be the reward of watching others view
your images!

For more, visit www.photonaturalist.net Article and photos by Vic Berardi
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#5 - How to position your camera

When photographing flowers, you will most
likely use a telephoto or macro lens with

a wide aperture (to get that great blurry
background), so proper focus is very subtle
and extremely difficult to achieve.

Positioning your camera so the sensor is
parallel to the most important plane of the
flower will help put all important parts of
the flower at the same distance from your
sensor, so all those parts will be in sharp
focus.
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If some parts of your sensor are further
away from the flower than other parts of Alpine Aster (Aster alpinus)
the sensor, then there will be parts on your

photo that are blurrier than others.

To illustrate this idea, consider the photograph at the beginning of this post-it was taken with
a 100mm macro lens, at f/5.6. This flower is almost perfectly flat, so the camera’s sensor was
almost perfectly parallel to its petals. If the sensor wasn’t parallel to the petals, then one side
of the flower would have been out of focus.

So, when you’re photographing a flower, don’t just think about what aperture you should use,

but also consider what the most important plane of the flower is, and make sure your sensor is
parallel to that plane. Otherwise, you won’t get the sharp focus you're looking for.

For more, visit www.photonaturalist.net Article by S. Berardi & photo by V. Berardi
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#6 - How to get sharper photos

With wildflower photographs, you want to show as much detail in the flower as possible, so it's
imperative you aim for sharp photos. Here are 6 tips to help you accomplish that:

#1 - Always use a tripod

| know—tripods are heavy, they take a long time to setup, and can cost a lot of money, but it’s
nearly impossible to get sharp photographs without one. Nothing keeps your camera more
still.

#2 - Enable mirror lockup

Normally, the mirror in your SLR will flip up immediately before the shutter opens, and this

flip can make the camera vibrate a little. Enabling mirror-lockup (disabled by default on most
cameras) will add a significant pause between the time the mirror goes up and the shutter
opens, letting any vibration die down before the photo is actually taken. Look in your camera’s
manual to find out how to enable this feature.

#3 - Use a remote shutter-release or timer

The less you touch your camera, the less it will shake (simple, huh?). When you press the
shutter button on your camera to take a photo, there’s a good chance you’ll shake the camera
a little. To prevent this, use a remote control to release the shutter, or you can just use the
timer on your camera (so any vibration you caused by pressing the button will die down before
the shutter is actually released).

#4 - Use manual focus

Autofocus is great for moving subjects or when you need to take photos quickly, but with

a somewhat stationary subject like wildflowers, you should always use manual focus. For
macro photography, manual focus is the only way to get sharp photos. Autofocus just doesn’t
work too well at close distances.

#5 - Shoot lots and lots of photographs

Because wildflowers are so gentle, the slightest breeze can send the flower shaking through
the air. Taking lots of photos will help you capture the flower in between these movements.

#6 - Use the sweet spot of your lens
Most lenses are sharpest in their “mid ranges.” For example, if your 70-200mm zoom lens
has a speed of f/4, then you’ll probably get the sharpest results from using /6.3 and zoomed

at 135 mm. Very rarely are lenses sharp on their “fringes.” Also, fixed focal length lenses are
always sharper than zoom lenses.

For more, visit www.photonaturalist.net Article by Steve Berardi
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#7 - How to get a perfect background

When you're trying to isolate a single
wildflower in your photo, it's very important
to choose the right background.

The perfect background always has three
essential qualities:

1. Strong contrast with the subject
2. Smooth seamless color
3. Completely out of focus

The first two properties are easy to
accomplish: just look around until you find
a flower viewable from an angle where the
background is made of just one (or a few)
smooth colors that contrast well with the
flower.

But, how do you get those awesome blurry
and out of focus backgrounds?

Well, there are three keys to getting that e . 4 “‘3
great smooth blur (also known as “bokeh”): ( A 8. 4 ‘5 “

i -

Chocolate Lily (Fritillaria biﬂora)

1. Use a long focal length
2. Maximize the distance between the subject and the background
3. Use a wide aperture (between /5.6 and f/8.0)

For #1, you’ll need a telephoto zoom lens (I use and highly recommend Canon'’s /4L 70-
200mm). The longer the focal length you use, the more blur/bokeh you’ll get.

For #2, you may have to do a bit of searching for the perfect flower. Not only do you want to
find a flower with perfect petals and coloring, but the flower also needs to have a smooth and
seamless background that’s far away (at least a few feet). This is much more important than

#1, so don’t ignore this!

Lastly, make sure you use a wide aperture. Something like /5.6 or /8.0, depending on how
much depth there is to the flower and the focal length of your lens (for longer focal lengths,

use a smaller aperture, such as /8.0).

Your search for the perfect flower may seem endless at times, but be patient and persistent.

Sometimes you'll spend hours looking for the perfect flower, but you’ll never fail to find it.

Ipsesag andls Ag 6002 (0) bLAdoD
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#8 - How to battle the wind

Wildflowers are gentle--very gentle.
The slightest breeze can send them
bouncing through the air. But, to get
sharp photos, you need a still subject.
So, how do you work with the wind to
get that flower to stand still for just a
second?

Well, you’re going to need some
patience. Although there may be

a strong breeze in the air, chances
are that it will stop at variable times
for just a few seconds. Be prepared
when this happens.

Ipsesag ane1S Ad 6002 (2) ybuAdod

Lace-Leaf Phacelia (Phacelia distans)
Use a fast shutter

Other than patience though, you can also battle the wind by using a fast shutter. You can
achieve this by using a higher ISO (200 or 400), or using a wider aperture.

It may be tempting to try and underexpose your shot to get an even faster shutter, but never
underexpose when shooting wildflowers. It's impossible to recover those brilliant colors in
post processing. Perfect exposure is absolutely necessary.

Use a wind blocker

Another way to help battle the wind is to have a friend hold up your homemade light diffuser
or another wind stopping device (jacket, shower curtain?).

Take lots and lots of photos

Since the wind is so variable and your flowers may only be still for a split second, it’'s nearly
impossible to anticipate these moments of perfect stillness. So, take lots and lots of photos to
ensure you capture the flower at a moment between these movements.

To increase the amount of photos you can take in a burst, switch to JPEG mode. Since it’'s
difficult, if not impossible, to fix poor exposures of wildflowers, RAW doesn’t give you much
advantage in this case.

There’s no such thing as a calm day

With wildflowers, even on a seemingly “calm” day, you're likely to see wildflowers bouncing
through the air. Remember, they’re gentle--very gentle. So, be patient, and be quick.

For more, visit www.photonaturalist.net Article and photo by Steve Berardi
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#9 - How to compose landscapes with wildflowers
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aIifornia Poppy (Eschscholzia californica)

If you live in an area that experienced a strong rain or snow season just prior to spring,
then you're in for a treat: wonderful carpets of wildflowers sprawled across your favorite
landscape.

Most of the same principles of great landscape photos also apply when including wildflowers,
but here’s a review of those principles with a few things to keep in mind when wildflowers are
also part of the scene:

Foreground. Usually, the job of the foreground is to lead the viewer’s eyes into the
background. But, when including wildflowers, sometimes the foreground becomes the most
dramatic part of the landscape. If you’re including just a small patch of flowers (like in the
photo above), then make sure you keep it off center (follow the rule of thirds). And, if you're
photographing a large field of flowers, try to shoot above them to produce a better feeling of
depth.

Background. When there’s wildflowers in the foreground, the background doesn’t have to
be too dramatic, it just has to be somewhat interesting and contrast well with the foreground.
Hills or mountains work perfect in this case, especially if the mountain is still snow capped
and there’s a clear blue sky.

Perfect light. Usually with landscapes, the perfect light occurs during sunrise and sunset.
Although this still holds for wildflower landscapes, you can also get great photos by shooting
at midday with a clear blue sky (or sometimes a partly cloudly sky). Use a polarizer to get a
deep blue sky that contrasts well with most wildflowers.

Shoot in RAW mode. You should always shoot in RAW with landscapes, since they never
require quick shooting (the only advantage of JPEG). However, be careful with the RAW
‘landscape” presets on your camera. Although they work great for most landscapes, they
always wash out the color of yellow wildflowers.

For more, visit www.photonaturalist.net Article and photo by Steve Berardi
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#10 - How to get butterflies in your photos
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Butterflies are really shy little creatures--have you noticed? They’re fine with you viewing their
stunning colors from afar, but if you try to get within a few feet of them, they’ll fly off in a hurry.

Too bad they don’t like humans as much as the mosquitos do.
So, how do you get them to pose for your photos?

Well, although they will rapidly retreat as you try to approach them, there’s actually a simple
way to get them to come back: wait. Patiently. When you see a butterfly fly off as you ap-
proach it, don’t try to chase it down. Instead, try this:

Stop

Setup your camera and tripod

Focus on the flower where the butterfly was before you scared it off
Determine the perfect exposure for the flower (fire a few test shots)

Switch to JPEG mode (so you can shoot photos faster)

Watch where your shadow is (most butterflies and insects only like the sun)
Wait for a butterfly to land (sometimes up to 20 minutes)

When they arrive, shoot photos continously to ensure you get a sharp shot

Nk~

For more, visit www.photonaturalist.net Article and photos by Steve Berardi
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#11 - Why it’s important to “leave no trace”

Okay, so this one isn’t really a tip for getting better wildflower photos, but when you’re out
there looking for the perfect flower to photograph, it's important to “leave no trace.” That
means, be very careful not to harm the flower by stepping on it, or worse: pulling it out of the
ground.

Whenever you’re in a natural environment, remember to:
Leave only footprints. Take only pictures.
Wildflowers often attract a very large crowd of people, so if everyone was careless and

stepped on flowers or picked them, then there wouldn’t be any left. Wildflowers are gentle.
Don’t jeopardize the life of a flower just so you can get a good photograph!

For more, visit www.photonaturalist.net Article by Steve Berardi
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#12 - How to sharpen your photos in Photoshop

There seems to be a lot of debate about the best sharpening method in Photoshop. Some say

it's “unsharp mask,” while others swear by “smart sharpen,” and a few have developed complex
multi-step workflows for sharpening their photos.

I've tried a few of these techniques, but the one | like best is High-Pass sharpening. It's my
favorite method for two reasons: it barely adds any noise to your photo, and it's a short and
quick process.

So, here’s how you do it:

1.) You'll need to have a flat image for this, so if you have multiple layers, merge them together
by selecting “Flatten Image” from the “Layer” menu.

2.) Create a duplicate layer of your image by selecting “Duplicate Layer” from the “Layer” menu.

3.) Go to the “Filter” menu, and go all the way to the bottom until you get to the submenu
labeled “Other,” and then click on “High Pass...”

4.) The goal here is to select a pixel radius large enough so it outlines the edges of your
photograph and shows a little bit of color (make sure the “preview” box is checked!). Usually
values between 4 and 10 work very well. Here are a few examples of radius values that are too
small, too big, and perfect:

5.) Click “OK” to apply the filter
6.) In the “Layers” window, click on the blending mode listbox, and select “Overlay”
7.) Your photo should now look like it's too sharp. But, don’t worry, the next step is to fix that!

Right next to the blending mode listbox, there’s an “Opacity” slider. Click on that and lower the
opacity until your photo looks sharp, but not too sharp. | usually set it between 30-45%.

For more articles like this,, visit www.photonaturalist.net Article by Steve Berardi
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#13 - How to darken a background in Photoshop

To make a wildflower really stand out in your photos, you’ll want a dark background, so
the bright colors of the wildflower really jump out at the viewer. This is really easy to do in
Photoshop, and here’s how:

1.) Use the “Elliptical Marquee” tool to circle your subject. If your flower isn’t circular, then
you'll need to use the lasso tool to outline it.

2.) Invert your selection by selecting “Inverse” from the “Select” menu.

3.) Add a new “Levels” Adjustment Layer by going to the “Layer” menu, then selecting “New
Adjustment Layer” and finally “Levels”

4.) Make your selection darker by dragging the leftmost triangle towards the right (see red
circle in screenshot below). The more you drag this triangle to the right, the darker your
background will get. Stop when you're satisfied, and click “OK”
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5.) You should now have a dark background, but there’s probably a sharp outline between
your subject and the background now. To get rid of this, go to the “Filter” menu and select
“Gaussian Blur” under the “Blur” submenu. Start at 100 pixels and keep increasing the value
until that sharp edge is gone and the dark background merges smoothly with your wildflower.

For more articles like this, visit www.photonaturalist.net Article by Steve Berardi
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The 1 minute summary of this book

#1 - Get to know the wildflowers around your area so you can identify them

#2 - To get the best light, shoot on an overcast day

#3 - If you can’t wait for an overcast day, wait for clouds or use an artificial diffuser
#4 - You'll need a shutter of at least 1/200 sec to battle the wind

#5 - Positioin your camera so the sensor is parallel to most important plane of flower
#6 - Use a tripod, mirror lockup, manual focus, and a remote shutter

#7 - Use a long lens and maximize the distance between subject and background
#8 - To battle the wind, use ISO 200 or 400, and take lots of shots

#9 - For landscapes, keep patches of flowers off center and use a polarizer

#10 - To capture butterflies in your photos, just wait patiently at a flower

#11 - Leave only footprints and take only pictures

#12 - Use high pass sharpening to make your photos super sharp

#13 - Darken a light background with a “Levels” adjustment layer

For more articles like this, visit www.photonaturalist.net Article by Steve Berardi
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Read more articles on our website!

If you enjoyed the articles in this eBook, the best way to thank us is to share this
file with a friend, and tell them about our website, the Photo Naturalist. We post
weekly articles on nature photography, just like the ones you read here.

Logon today, and signup for free updates!

www.photonaturalist.net
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